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Cover Image

The image on the cover was taken by the award-winning astro-photographer Wally Pacholka, on 
December 13 2004 (http://www.astropics.com, reproduced with permission). It captures some of the 
many wondrous astronomical phenomena that can be seen by observing the night sky with the 
most readily-accessible instrument of all: the unaided eye. 

On the bottom left, just over the hill, is Sirius, the brightest star in the sky. Well above Sirius is part 
of the constellation of Orion the Hunter. The three stars running down the image near the top-left 
are imagined to be jewels in Orion’s belt, the three stars running diagonally down and to the right 
just below  the belt form Orion’s sword, while the two bright stars beyond the sword are his knees. 
The middle “star” in the sword (visible as a fuzzy patch to the naked eye) isn’t really a star at all: 
rather, it is a “nebula,” an enormous cloud of  gas and dust, where thousands of new  stars are being 
born. Off  the top of  this image lie stars forming Orion’s  head and shoulders, along with his shield 
and club, which he is using to battle Taurus the Bull, while in pursuit of the beautiful seven sisters 
known as the Pleiades. These imaginary patterns make this one of the most evocative regions of 
the night sky, and are easily recognized by beginning amateur astronomers, even in brightly-lit city 
skies, in the evenings of late fall and early winter. 

A meteor streaks across the sky below  and to the right of Orion while, above and to the right of the 
meteor, what looks like another fuzzy patch, lies a comet. This is comet Machholz, which was visi-
ble to the naked eye for a few  months in late 2004 and early 2005, coming within about 50 million 
kilometers of  the Earth, as it very gradually moved across the background of fixed stars; this comet 
will not approach the Earth again for over one-hundred thousand years.

This black-and-white reproduction cannot capture the fact that many objects in the sky have vivid 
colours which can easily be discerned by the naked eye. A colour reproduction of this image was 
featured in the December 22 2004 edition of Astronomy Picture of the Day, go to 
http://antwrp.gsfc.nasa.gov/apod/ap041222.html. 
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A S T R O N O M I C A L  S Y M B O L S

S O L A R  S Y S T E M

! . . . Mercury ♀ . . . Venus ⊕ . . . Earth

♂ . . . Mars $ . . . Jupiter % . . . Saturn
& . . . Uranus È . . . Neptune ' . . . Pluto
" . . . Sun

S I G N S  O F  T H E  Z O D I A C

! . . . Aries " . . . Taurus # . . . Gemini
$ . . . Cancer % . . . Leo & . . . Virgo
' . . . Libra ( . . . Scorpius ) . . . Sagittarius
* . . . Capricornus + . . . Aquarius , . . . Pisces

T H E  G R E E K  A L P H A B E T


 
 
 
 
 Α, α ... alpha 
 
 Β, β ... beta 

 
 Γ, γ ... gamma 


 
 
 
 
 Δ, δ ... delta 

 
 Ε, ε ... epsilon 
 
 Ζ, ζ ... zeta 


 
 
 
 
 Η, η ... eta 
 
 
 Θ, θ ... theta 
 
 Ι, ι ... iota 


 
 
 
 
 Κ, κ ... kappa 
 
 Λ, λ ... lambda 
 
 Μ, µ ... mu 


 
 
 
 
 Ν, ν ... nu 
 
 
 Ξ, ξ ... xi 

 
 
 Ο, ο ... omicron 


 
 
 
 
 Π, π ... pi 
 
 
 Ρ, ρ ... rho 
 
 
 Σ, σ ... sigma 


 
 
 
 
 Τ, τ ... tau 
 
 
 Υ, υ ... upsilon 
 
 Φ, φ ... phi 


 
 
 
 
 Χ, χ ... chi 
 
 
 Ψ, ψ ... psi 
 
 
 Ω, ω ... omega



P H Y S I C S  1 9 0 : 

 P R E P A R A T I O N S  F O R  S T A R R Y 

N I G H T S  W I T H  T H E  N A K E D  E Y E

O V E R V I E W

The scientific revolution has  fundamentally and unalterably transformed our concep-

tion of the universe, and of humankind’s place in it. The breadth and depth of our present 

understanding of the cosmos owe to a fundamental principle of the scientific method, which 
is  to perform experiments that confront our preconceptions with data, thereby approaching 

the truth of nature’s  mysteries. In this  course you can participate in the thrill of scientific dis-

covery in a small, but potentially rewarding way, by doing a series  of basic experiments in 

astronomy and physics.

The experiments in this activity guide are roughly divided into two categories: a set 
of astronomy projects, which involve observations of the night sky, to be done on several 

evenings over the course of the semester; and a set of physics  labs, to be done in a tradi-

tional laboratory setting, in our undergraduate physics lab. 

The first two sections of this activity guide are required reading in the first 

week of classes: read this section, Preparations for Starry Nights with the Naked Eye; and 
read the excerpts which have been reproduced from the textbook 365 Starry Nights, by 

Chet Raymo. These readings are required in order to prepare for the experiential activities 

which constitute a significant portion of the graded work in this course.

The astronomy projects consist of observations of the stars, planets, and the 

Moon, which you make outside of classroom time. No special equipment or telescope is 
needed: the observations  are done using the naked eye. Each project has a detailed set of 

instructions. You should carefully review the instructions for each project well in advance, 

and once again shortly before going outside to conduct your observations. 

The first experiential activity of the semester is the Astro Computer Lab: Getting 

Around the Night Sky with SkyChart III, which takes place in the undergraduate physics lab 
in the second week of class. You do this  computer lab, as  well as  the physics labs, in the 

lab section that you were assigned when you registered for the course. Read over the 

script for the Astro Computer Lab  before you come to the lab. All other astronomy activities 

consist of outdoor observations. More information on the observation projects  is given be-

low.

The physics experiments are designed to explore a few of the more basic princi-

ples and tools that are used by astronomers, as  well as some basic principles of data 

analysis and visualization. Physics labs are a natural part of an astronomy course, because 

physics provides the universal laws of nature, and the associated experimental tools, that 
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are used by astronomers to infer the properties of objects that are far removed from direct 

contact. The first physics  lab takes place in the third week of class. Consult the course web 

page for the complete lab schedule. 

You must bring the script for a physics  lab with you to your assigned lab section. At-

tendance will be taken; you cannot change your lab section without permission. You will re-
cord and analyze the data for the physics labs on your lab scripts, which will be handed-in 

at the lab. Read over the scripts before you come to the lab.

This  course has a scheduled weekly tutorial section. The tutorials will be used to 

provide a preview of the upcoming physics labs and astronomy projects, and are essential 

preparation for these experiential activities; attendance is required. 

Astronomy Observation Projects
You are required to write a short report on each astronomy project that is se-

lected by the course instructor. Reports must be typewritten. Two double-spaced type-

written pages is sufficient, but must include the following labeled sections: 

★Title: Include project name, your name, partner names, & date report submitted;

★Overview: Provide a one-paragraph description of the project, including its pur-

pose; 

★Narrative: One or two paragraphs summarizing your experiences, including how 

you prepared for the project, and giving your overall impressions of your activities 

as they unfolded over the course of your observation sessions;

★Observations & Analysis: One or two paragraphs detailing the observations that 

you made, and providing an analysis of the results;

★Conclusions: Include a one-paragraph discussion of how successful the observa-

tions were, and what concepts or relationships were demonstrated;

 You must keep a logbook where you record your astronomy project observations.  
A blank log is included in this activity guide, and copies can also be obtained from the 

course web page; you should use a separate copy of the log to record each night of obser-

vations. Record your data in the log as  soon as you take it; do not wait until after your ob-

servations to record the information. 

★The relevant logbook records must be attached with each project report. Project 
reports are separate from logbook records, and must satisfy the above criteria.

Note: Completed projects  must be handed-in according to a schedule to be an-

nounced in class. You may be required to do only a portion of the astronomy projects for 

course credit: your instructor will provide details. You may also be requested to show your 

log-book to your course TA at selected times during the term.

The course instructor and TAs will hold several on-campus “star nights,” in or-

der to orient you to the night sky, as early in the term as  possible. A small telescope or two 
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may also be on hand. The class will meet, at a location to be announced, usually around 

6:30PM, but only on specific nights  which will only be announced earlier in the day, when 

the weather looks promising. Star nights will be subject to cancellation late in the day, de-

pending on how the weather develops (if a possible star night has been announced you will 

receive a confirmation, “good to go,” or not, either in class, or by email late in the after-
noon). Several star nights will be scheduled as early in the term as possible, in order to 

give everyone a reasonable opportunity to attend one. You should therefore regularly check 

your email and the course web site for messages from the instructor. 

Attendance at one star night and full participation in the astronomy projects 

throughout the term are required parts of this course. If your evenings are too busy to 
allow you to make evening observations  when the weather permits, and to accommodate 

the star-night and astronomy project schedules, then you must drop the course. 

The astronomy observation projects require careful advanced preparation. 

Read the project instructions before you go outside. Scheduling of the various projects also 

requires advanced planning; in particular, some objects can only be observed during spe-
cific periods of time. Projects I & II can be done together in one or two nights. The other 

projects each require a few nights of observation, but you will only have to spend a few 

minutes outdoors for each observation. Consult the project instructions for scheduling de-

tails.

With advanced preparation you may be able to do most of Astro Projects I & II dur-
ing one on-campus star night. After you attend one star night you are expected to work on 

the remaining astronomy projects on your own time, and you can conduct your observa-

tions from any convenient location (you do not have to stay on campus; for example, try to 

find a reasonably dark location close to home). 

Take full advantage of the earliest clear nights in the term. Vancouver weather is 
unpredictable so do the projects ASAP: do not put them off. 

 Here are a few tips for successful observations:

★Dress warmly (including on the star nights): even if it seems relatively mild during 

the day, you can get very cold standing around looking at the sky at night!

★Before starting your observations give your eyes at least ten to fifteen minutes to 
adapt to the dark, so you are more sensitive to faint starlight.

★You will need a flashlight to read your sky charts and notes. Cover the flashlight 

with red paper or cellophane: red light doesn’t spoil your eye’s adaptation to the 

dark the way white light does 

You are also strongly encouraged to work in groups of two or three, both on the 
physics labs and the astronomy projects. Working in a group is particularly helpful in doing 

the astronomy projects: the extra set of eyes and perspective provided by a partner can be 
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invaluable in finding one’s  way around the sky. You must record the names of any partners 

on the observation logs, project reports, and physics labs reports. 

 The textbook 365 Starry Nights, by Chet Raymo, excerpts  of which are repro-

duced in this activity guide, gives an introduction to the sky, month-by-month, suitable for 

beginning amateur astronomers. The excerpts included here primarily cover the months of 
January through April, and most of the objects described in these portions of the text can 

be seen throughout the winter and into early spring. Note that you do not have to go out 

precisely on the date specified in each excerpt of the Raymo text, as the sky changes  very 

slowly from month to month.

 Winter skies feature some of the most beautiful and prominent star patterns in the 
entire sky, including Orion, Taurus the Bull, the Pleiades, and Leo the Lion. These and 

other features of winter skies are described in detail in the excerpts  of 365 Starry Nights, 

and will be explored in Astro Projects I & II, in the Astro Computer Lab, and during the star 

nights. We will also study the Big and Little Dippers, described in the May excerpts; these 

are “circumpolar” star patterns, which means that they can be seen year-round in much of 
the northern hemisphere. The final excerpt from 365 Starry Nights is  from November & De-

cember, and describe the variable star Algol, and the related constellations of Perseus and 

Cassiopeia, which are all circumpolar objects, and will be explored in Astro Project III.

Academic Honesty
 You have an obligation to understand our university's  policies on academic honesty 
and student conduct. Ignorance of university policies is  no excuse. Be sure to carefully re-

view the following information, which includes particular issues relating to this course. Also 

consult the course web page for links to relevant SFU policy documents and helpful infor-

mation from the library on written coursework. 

 A major portion of the grade in this course comes from the physics labs and astron-
omy projects. These experiential activities include data collection and making observations, 

and in doing this work you are strongly encouraged to collaborate with other students, in 

groups of two or three. However, each partner must actively contribute to the data collec-

tion and project observations. You are also free to discuss the significance of the results 

with your partners, but each partner must be an active participant in such discussions, and 
must make significant contributions to the resulting ideas. 

 Although you are to collaborate with partners in taking data for the labs and projects, 

the work you hand in must be your own. In particular, while you share the data with your 

partners, you must write your work in your own words. Do not share your written work. 

 Copying whole or part of another’s work, and fabrication of even part of your data, 
are serious forms of dishonesty, and will be severely dealt with. The instructor and TAs will 

closely monitor work for plagiarism and falsification, in the physics lab scripts, the astron-

omy project reports, any assignments, and the exams.
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Name___________________________________ Student #________________________

Project Partners ___________________________________________________________

Astronomy Project Title: ____________________________________________________

Date: _________________________ Start Time: ___________ End Time: ___________

General Location (e.g. Burnaby) _____________________________________________

Weather and sky condition (e.g. partly cloudy or hazy, etc.) ________________________

Limiting magnitude: _______ based on ____ UMi (see Little Dipper chart in Project I)

Moon’s phase & direction (e.g. First Quarter, West): _____________________________

Notes (use boxes below to sketch and label relevant parts of the sky): ________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

   

O B S E R V E R ’ S  L O G

Edmund Scientific Star and Planet Locator Star Magnitudes:           
                                                                                                          -1         0        1        2         3        4 

Observer’s Log                                                                                                                     ©2008 Simon Fraser University

Label compass directions





P H Y S  1 9 0 :  A S T R O  C O M P U T E R  L A B

G E T T I N G  A R O U N D  T H E  N I G H T  S K Y 
W I T H  S K Y C H A R T  I I I  S O F T W A R E

 Goals

★Learn how to use the SkyChart III planetarium software to identify some prominent 
features of seasonal skies, and to gather information for an observation project.

 Material

★Bring your copy of the Edmund Scientific Star and Planet Locator, which came with 

your textbook, to the undergraduate physics laboratory.

★Computers will be provided at the laboratory, with SkyChart III software installed.

 Background

 Amateur and professional astronomers alike know that advanced planning is  essen-

tial to successful observations. The sky is full of change, even though the stars and constel-

lations remain essentially fixed in position relative to each other (over many thousands of 
years). Many changes are regular and predictable. The stars appear to move together 

gradually across the sky over the course of a night, as the Earth rotates on its  axis. The sky 

also appears to change slowly from one night to the next, as the Earth moves in its orbit 

around the Sun. Moreover, the Moon travels around the ecliptic each (lunar) month, with its 

phase changing from day to day, while the planets  gradually change their positions  relative 
to the stars, due to the combined motion of the planets and the Earth in their orbits.

 An observer is also presented with an almost endless variety of celestial objects to 

choose from, some plainly visible to the naked eye (including stars of breathtaking colour, 

as well as planets and the Moon), and with a spectacular array of “deep sky” objects ac-

cessible to binoculars and small telescopes (such as distant star clusters, nebulae, and 
galaxies). The objects  that are “up” in the sky change over the night and with the seasons. 

New and unexpected phenomena also occur, such as the appearance of a new comet. 

 It can therefore be advantageous to organize a observing plan in advance, by con-

sulting an up-to-date source of astronomical information (though it’s  also pleasing to just go 

out and look at the night sky on a whim!). Fortunately, there are many resources for navi-
gating one’s  way around the night sky. Popular monthly astronomy magazines, such as 

Sky&Telescope, and Astronomy, provide timely guides to the night sky (see the course web 

page for links to these and other sources). The textbook 365 Starry Nights, by Chet Raymo, 

excerpts of which are reproduced in this activity guide, is particularly helpful as a guide for 

beginning amateur astronomers. 

 Planetarium software such as  SkyChart III, which we explore in this  lab, provide a 
powerful resource for keeping track of regularities in the changing sky, and for planning ob-
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servation sessions. As in a physical planetarium, the software displays  an easy-to-interpret 
“virtual” sky, and contains a huge catalogue of celestial objects  (a free and fully functional 
demo copy of SkyChart III can be downloaded at http://www.southernstars.com/skychart/). 

 The Edmund Scientific Star and Planet Locator, which came with your textbook, is  a 
more modest but very convenient and useful paper star chart, and is another indispensable 
tool, particularly for use “in the field.” The use of the Edmund Star Locator (also referred to 
as a planisphere) is the subject of Astro Project I. 

 Another fantastic resource for what to see in the night sky with the naked eye is a 
weekly five-minute video by Jack Horkheimer, the wacky director of the Miami planetarium. 
This feature is produced for PBS Television, and can be viewed on the web at:

http://www.jackstargazer.com.

About half-way down that web page is a link to past and upcoming installments; the link is 
easy to miss, so look along the left-hand margin for: “To see any episode produced in the 
last 12 months.” 

 In this lab you will learn to use SkyChart III to familiarize yourself with some promi-
nent features of seasonal skies, and to gather information for an observation project. You 
will also watch the latest episode of Jack Horkheimer and, following Horkheimer's direc-
tions, you will see if you can identify what he is talking about in the “virtual” sky created by 
the SkyChart III software.

 The rest of this script is  organized in four parts. Part I) contains a set of instructions 
to initialize the program for use at home: these steps do not have to be done in the physics 
lab. In part II) you will learn how to use some of the basic features of the software to identify 
regions in the sky of interest. In part III) you will print a star chart for the current edition of 
Jack Horkheimer, and in part IV) you will gather information for an observation project. 

 Notes: You may find it helpful to compare the SkyChart III display of a particular re-
gion of the sky with the star chart on the Edmund Scientific Star and Planet Locator.

 The > symbol below refers to a menu or submenu item in the SkyChart III program. 

 Part I): Initialize the program (for use at home)
 Note: steps A) to D) have already been done on the computers in the physics labs.

 A) One-time initialization to display “traditional” constellations

 In its default configuration SkyChart III displays constellations in a “modern” form, 
which differs  from the “traditional” constellations that are used in most other star charts 
(such as  the Edmund Star Locator, which we use in our observation projects). If you use 
SkyChart III at home, you should consider installing traditional constellations, as follows.

 First, you need to download the file “TraditionalConstellations.txt” from the SkyChart 
website http://www.southernstars.com/skychart (click the “Other Downloads” link in the left 
margin, and look at the end of the web page for the file).

 Next, follow these instructions:

 > File > Import > SkyChart Text File ... Select the file “Traditional Constellations.txt”.

 > File > Delete Database File ... Select file “Figures.skd” in “Constell” folder, in the
            “Database” folder, in the SkyChart III program folder.
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 B) One-time initialization for location to Vancouver

 > Computation > Location > View From Earth
  > Enter Vancouver in Location, and enter the following information:
  > Longitude  –123 11 00  (include either a minus sign, or a “W”)
  > Latitude +49 12
  > Altitude 4
  > Time Zone -8  (Be sure to include the minus sign)
  > Add to Menu  (PC users: Add to List)
  > Use as "Here"
  > OK

 > File > Save Settings as Default 

 C) Set “virtual” sky to appear as it does to the naked eye in the city

 > View > 90o Field   (to get the “field of view” of a naked eye observer)

 > Draw > Remove check on Deep Sky Objects

 > Draw > Remove check mark on: Automatic Limits

 > Draw > Symbols & Grids ... > Brightest Magnitude: 0.0
                                                          > Faintest Magnitude: 5.0
                                                          > Labels to Magnitude: 3.5
                                      > OK

 File > Save Settings as Default

 D) Additional setup

 > Draw > Symbols & Grids ... > Check “Ecliptic” box (near middle-right)

         > Remove check on “R.A./Dec.” box 

         > Remove check on “Boundaries” (bottom-left).

         > OK.

 > Draw > Put check mark on : Grid Lines

 > Draw > Put check mark on : Object labels

 > File > Save Settings as Default

 Part II): Try-out some basic features
i) Try “dragging" the sky around using the mouse

ii) > Computation   > Date & Time  (For these examples, set to: 2008/01/11 20:00:00
     to see the sky on January 11 2008 at 8PM.)
       > OK

iii) > View > Center Horizon > North (“Drag” the sky down see the Big & Little Dippers,
                                                       with date/time set as above.)

iv) > View > Center Horizon > East (“Drag” the sky down & left to see Gemini, Orion,
                          Taurus, and Mars.) 
     (Notice the colours of the stars and Mars!)

Getting Around with SkyChart III                              ©2008 Simon Fraser University                                              ALAB-3



v) Click on any object (e.g. Mars or Moon or star) to pop-up an “Object Info” window.

★One needs to position the cursor arrow very close to an object symbol in order to 
get the “Object Info” window to open for the correct object.

vi)  > Animation  > 1 Minute
    Animation  > Animate Forward (Watch objects rise from East and set to West)
     Animation > Animation Off

vii)  > View > Center Object .... > Polaris >  Find > Select

★Now run animation again to see stars circling the pole star!

viii)Reset the date & time to 2008/01/11 20:00:00.

ix) > View > Center Planet > Moon
> Animation > 1 Day
> Animation > Step Forward (single steps, do not run a continuous animation)

★Repeatedly step forward 1 day at a time to follow the Moon’s changing position 
relative to the background stars (for about 13 days, until January 24, after which it 
disappears below the Eastern horizon, since thereafter it rises after 8PM).

★Notice how the Moon stays within a few degrees of the ecliptic, first somewhat 
above the plane of our orbit around the Sun, and then somewhat below it.

★You can also follow the changing lunar phase (reduce the field of view to get a 
close-up of the Moon’s disk, for example: View > 5o Field).

x) Measure the angular separation between the stars Castor and Pollux in the constel-
lation of Gemini, as follows (see February 21-22 in 365 Starry Nights): 
> Date & Time: 2008/01/11 20:00:00.
> View > 90o 
> View > Center Horizon > East
★“Drag” the sky down a bit to view Gemini. 

> Draw > Put check mark on: Mouse Coordinates.

★Click on Castor (α Gem) and drag the mouse to Pollux (β Gem), 

and continue to hold the mouse button down for the next step.

★Read the angle (“Sep”) near the upper-left corner of the screen (here about 4.50).

> Draw > Remove check mark on: Mouse Coordinates.

 Part III): Print a map of Jack Horkheimer’s sky

 Go to Jack Horkheimer’s  web site (see pg. 2 of this script) and listen to the 5 minute 

episode for this  week. Use SkyChart III to see if you can identify some of the objects de-

scribed by Horkeimer. 

 Print a star chart of some region described by Horkeimer, as follows: 

 First, roughly centre the planetarium viewer on the region of sky of interest, and then 

select: > File > Print. You get the following dialog box: “The chart will print better if ... the 

sky background is changed to white. Make changes now?” Be sure to click on “Yes.” You 

may need to experiment with the portion the sky that is actually printed: try dragging the sky 
around and print again until you get a satisfactory printout.
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 A sample map produced by the software is shown below. This  map was made for 

January 11 2008 at 9PM (the view of the constellations  will be identical in early-winter of 

any year, but the positions of Mars and Saturn apply only around the specified date).

 The constellations Orion and Taurus are on the far right, with Gemini near the cen-

tre, and part of Leo the Lion on the bottom left. The stars α Ori and β Ori in Orion are Be-

telgeuse and Rigel, respectively, while the brightest star in the sky, Sirius, is α CMa (near 

the bottom-right). The brightest star in Leo is Regulus, and is  labeled α Leo. Notice Mars 
and Saturn, both very close to the ecliptic.
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 Part IV): Planning an observation project

 To illustrate the use of SkyChart III in planning observations, make a plot of the mo-
tion of Mars over the course of the term (the subject of Astro Project IV), as follows:

> Computation > Date & Time: 2008/01/11 20:00:00 (Jan. 11 2008 at 8PM)

> View > Center Planet > Mars

★Click the symbol for Mars in the window centre to pop-up an “Object Info” window 

★Click “Trail On” in the “Object Info” window: an “Edit Object Trail” window opens 

★Click OK in “Edit Object Trail” window.

★Leave the Object Info window open for the rest of the exercise.

★Set the Animation in steps  of one week, and Step Forward in single steps, until the 
end of term.

★As Mars changes position, take note of its changing magnitude, as recorded in the 
Object Info window

★Notice how Mars is  in retrograde motion during the early part of term, moving to the 

West relative to the stars. It reverses its motion near the end of January, thereafter heading 

to the East in its prograde cycle. Also notice how Mars dims substantially over the term.

★Questions: What are the magnitudes of Mars near the beginning and end of term?
 Approximately how far in angle does Mars move relative to the stars? 

★Here is a sample map produced using the above instructions.
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  I
G E T T I N G  A R O U N D  T H E  N I G H T  S K Y 
W I T H  T H E  E D M U N D  S T A R  L O C A T O R

 Goals

★Learn to use the Edmund Scientific Star & Planet Locator, which came with the text-

book, to plan and conduct some observations of the night sky, including the identifi-

cation of some prominent constellations, stars, and planets.

★Learn to estimate the magnitudes of stars and planets.

 Observation Plan

★With thorough advanced preparation and planning, the observations for this project 

can be done in a single evening. You may be able to do most of this  project, and the 

next one, during the first on-campus star night.

 Background

 The Edmund Star Locator is a star chart, or “planisphere” (which literally means “flat-

tened sphere”). It can be used to identify prominent features in the night sky, at any time of 

the year, and at any time of night. This type of planisphere is also called a “star wheel,” be-
cause the chart is printed on a disk that can be rotated about a rivet in the disk’s centre.

centre of oval 
(Zenith)

rivet 
(Polaris)

North

South

E
ast

W
es

t


 The above photograph illustrates the use of a planisphere. A planisphere is helpful 

for planning an observing session, because it shows at a glance what will be “up” in the sky 
at a particular time, and it is handy for use “in the field,” in order to identify constellations 

and stars  of interest. It provides a portable “snapshot” of the entire sky, and you should use 
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it routinely in planning your observing sessions, and in finding your way around the sky at 

night. 

 You may also find it helpful to consult the planisphere when using the SkyChart III 

planetarium software to “zero in” on a more detailed region of the sky. 

 A star wheel is designed for use at a particular latitude: the entire portion of the ce-
lestial sphere that can be viewed from that latitude, over 24 hours, is projected onto a flat 

disk. The Edmund planisphere is designed for latitude 45 degrees north, which gives a 

good representation of the sky as seen from Vancouver. Note that the projection of the ce-

lestial sphere onto a flat disk means that some regions of the sky will appear distorted on 

such a star chart; constellations near the southern horizon are shown on this chart in an 
elongated (“stretched”) form, compared to their actual appearance.

 Only half of the celestial sphere can be seen from the surface of the Earth at a given 

time. That celestial “dome” is represented by a large oval which is cut into a grey sheet 

covering the rest of the star wheel (see the photograph). The edges of the oval represent 

the horizon in different directions. The centre of the oval represents the point directly above 
an observer’s head, also known as the zenith.

 The Earth’s rotation on its  axis  causes celestial objects to appear to rotate in great 

circles, about an axis through the celestial poles, once every 24 hours (as we will discuss in 

class). It so happens that the star Polaris, also known as the “Pole Star,” is very close to the 

north celestial pole. The rivet on the star wheel, about which it can be rotated, corresponds 
to the location of Polaris in the sky.

 Also shown on the planisphere is a solid white line marked “EQUATOR,” which rep-

resents the projection of the Earth’s equator onto the celestial sphere, and a dotted white 

line marked “ECLIPTIC,” showing the apparent path taken by the Sun, Moon and planets 

against the background of fixed stars.

 The Edmund planisphere bills itself as star and planet locator, however the planets 

cannot be printed on the star chart because their positions  are too changeable. The flip-

side of the planisphere does give a table which lists the constellation in which each planet 

is found, month-by-month, over several years.

 You may also find it useful to consult popular magazines such as  Astronomy, and 
Sky & Telescope, which provide monthly summaries of interesting objects in the sky, as 

well as somewhat more detailed monthly sky charts.

 How to use the Star Wheel

 To use the star wheel you must follow two steps:

1) The star wheel must first be “set” to a particular date and time. 

To do this, find the desired date printed on the edge of the blue disk, and rotate the 

disk until the date is lined up with the desired time, which is printed in small blue let-
ters near the edge of the grey sheet covering the star chart. If you observe the sky 
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over a period of time, you will want to periodically update the current time on the star 

wheel, rotating the disk to mimic the apparent rotation of the celestial sphere.

Note: The times printed on the planisphere are in “Standard Time.” If you are on 

Daylight Savings  Time (DST), generally from the second Sunday in March to the first 

Sunday in November, then subtract one hour from your local DST to convert to stan-
dard time on the planisphere.

2) Your view of the sky will depend on the direction you face. 

For example, to use the chart while facing north, hold the planisphere over your 

head, with the word “North” at the bottom (see the photograph). If you then turn to 

the left to face west, for example, you must rotate the planisphere so that “West” is 
then at the bottom, and so on.

Note: To orient the star wheel it is  very helpful to start with a known constellation, or 

from a well-defined compass direction (such as “North”). Then, as you turn your 

head to face towards another constellation or direction, turn the star wheel at the 

same time, so that the orientation of the star patterns  on the planisphere matches 
their orientation in the sky.

 Star magnitudes

 As we will discuss in class, astronomers use an apparent “magnitude” scale to “rank” 

stars according to how bright they appear as viewed from Earth. This scale originated with 

the ancient Greek philosopher Hipparchus in the 2nd century BC.

 Fainter stars  are assigned larger magnitudes. In the modern magnitude scale the 

faintest stars that can be seen by the naked eye have magnitude about 6.

 The brightest stars  in the sky generally have magnitude around 0, including the blue-

giant Rigel in the right knee of Orion. Magnitude 1 stars are also very prominent: a winter-

sky example is the red-giant star Aldebaran, the red “eye” in Taurus the Bull..

 Magnitude 2 stars are also quite noticeable, even in bright city skies, and these stars 

often form the outline of constellations: examples are the three stars in Orion’s belt, and the 
pole star Polaris (which many people mistakenly believe is the brightest star in the sky). 

 Magnitude 3 stars  are much less  notable: examples are the three stars in Orion’s 

head. Magnitude 4 stars are generally quite hard to see in city skies; the stars in the middle 

of the “handle” of the Little Dipper are of fourth magnitude.

 Negative magnitudes are also used: the brightest star in the entire sky, blue-white 
Sirius (south-east of Orion), has a magnitude of about -1.5. Venus is the brightest celestial 

object, apart from the Sun and Moon, and it has a magnitude of around -4. 

 The size of a star’s “dot” on the planisphere is used to roughly indicate its relative 

brightness. Bigger dots are brighter stars. The magnitudes associated with different-sized 

dots are printed at the bottom of the Observer’s Log Book. 
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 Two objects which differ by 5 magnitudes differ in intensity by a factor of 100. Mag-

nitudes form an exponential scale, similar to the Richter scale that is used to rate earth-

quakes. A difference of precisely one magnitude means a difference in intensity by a factor 

of 1001/5 ≈ 2.51. Try this  example: compare Rigel (magnitude 0.18) with Betelgeuse (magni-

tude 0.45). Rigel is 2.51(0.45-0.18) ≈ 1.3 times (or 30%) brighter than Betelgeuse.

 How to estimate magnitudes

 To measure an object’s  magnitude you should compare its observed brightness with 
that of other stars whose magnitudes are known from a reference such as planetarium 

software or a star chart. Ideally one should use two comparison stars, one a little brighter 

than the object under study, and another a little dimmer. One can then estimate that the 

magnitude of the object must lie in between the magnitudes of the comparison stars.

 Instead of using the size of the dots  on a planisphere, which provide only very rough 
guides to star magnitudes, you can use SkyChartIII to get accurate magnitudes for thou-

sands of objects. An example of a useful comparison chart is given on the next page.

 Another consideration is that the eye responds differently to different colours (with 

greatest sensitivity to yellow-green in weak light). Colour sensitivity also varies from one 

person to another. Hence ideally one should compare objects of roughly the same colour. 

 For example, many people actually find that Betelgeuse appears to be brighter than 

Rigel. In fact Betelgeuse has  historically been considered the “prime” star in Orion, and is 

designated “alpha” (α Ori), while Rigel is designated as the “second” star, or “beta” (β Ori), 

despite the fact that it is actually brighter. 

 Another interesting comparison, in the same region of the sky, is between Betel-
geuse and Aldebaran (magnitude 0.87), both of which are reddish-orange in colour. Most 

observers will agree that Betelgeuse is easily the brighter of the two (the magnitude calcu-

lation is that Betelgeuse is 2.51(0.87-0.45) ≈ 1.5 times, or 50%, brighter than Aldebaran).

 Project Preparations

 Familiarize yourself with some prominent features in seasonal skies by reading the 

excerpts from 365 Starry Nights. Note that you do not have to do the observations de-

scribed in 365 Starry Nights precisely on the specified days or even months. Also consult 
Jack Horkheimer’s weekly video digest, described in Astro Computer Lab: Getting Around 

the Night Sky, for a current and lively guide to observing the night sky with the naked eye. 

 Since this  is your first observation project re-read the introductory section of this ac-

tivity guide, Starry Nights with the Naked Eye, for important information on how to conduct 

and report your observations.

 For optimal viewing of the stars  you want to pick a clear night without too much 

moonlight so, if possible, avoid nights  near a Full Moon. You can do your observations  from 

anywhere that is convenient, even in front of your residence, although you will see more 

and fainter objects  if you find a dark location, away from direct lighting. If the Moon is in the 

sky, make a note of its phase and location relative to the region of sky that you observe.
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 Observation Details

(i)  Make a sketch in your log-book of two constellations that 

you observe. Include Orion as one of the two constellations.

 Do not reproduce what is shown on the planisphere. In-
stead, sketch the actual stars that you see. The planisphere 

is  only a guide to help you find objects in the sky; your log 

book should only record the genuine data produced by your 

own observations.

(ii) Compare the stars Betelgeuse & Rigel – which one appears 

brighter to you? Also, estimate how much brighter Betel-

geuse appears compared to Aldebaran in percentage terms; 
does your observation agree with the calculation on the last 

page?

(iii) Estimate the magnitude of the faintest star you can see 

(called the “limiting magnitude”). The stars in the Little Dip-

per are very convenient for estimating the limiting magni-

tude, since these stars span a range of magnitudes from 

about 2 to 5. Magnitude 5 can rarely be achieved in city 
skies, and frequently even the fainter 4th magnitude stars in the handle of the Little 

Dipper can’t be seen.

 The limiting magnitude should be recorded in your log on every night of observation.

 Note: Decimal points in the star magnitudes are omitted on the Little Dipper Magni-

tude Chart, in order to avoid confusion with star symbols  (e.g. the number “21” next 
to a star means it has magnitude 2.1)

 How to find Polaris

★As measured by its brightness Polaris is a very average star, only magnitude 2, 

neither exceptionally bright nor especially faint. The other stars  in the Little Dipper are gen-

erally quite dim. It can therefore be difficult to positively identify Polaris, even when looking 

in the right part of the sky, without using other more familiar stars to confirm its location.

★A common trick favoured by amateur astronomers to identify Polaris is to use the 

Big Dipper, which is very noticeable because it is big and bright, to “point” the way to Po-

laris. In fact, the two stars  at the end of the bowl in the Big Dipper point almost directly to 

Polaris, as described in the May 8-9 excerpt from 365 Starry Nights on pg. NIGHTS-20. 

★A helpful drawing of the pointer is  shown on the November sky chart on pg. 
NIGHTS-23, and is also printed on the Edmund Scientific Star and Planet Locator.

      α    20

   δ   44

  ε    42

            ζ    43

     η     50             21
                            β

                      γ      30

Little Dipper 
Magnitude Chart
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  I I

A N G L E S  I N  T H E  S K Y

 Goals

★Familiarize yourself with the concepts of altitude and azimuth on the celestial 

sphere. Learn how to quantitatively estimate angular positions and the angular 

separation between celestial objects. Estimate the altitude of the “pole star,” Polaris, 
which is approximately equal to an observer’s latitude.

 Observation Plan

★With thorough advanced preparation and planning the observations for this project 

can be done in a single evening. You should be able to do most of the project during 

the first on-campus star night.

 Background

 Two coordinates are needed to specify the location of an object on the celestial 

sphere (as we will discuss in class). Altitude and azimuth define one convenient set of an-

gular coordinates. 

Zenith:
(Altitude = 900)

Horizon
(Altitude = 00)

© 2005 Pearson Education, Inc., publishing as Addison Wesley


 The altitude of an object on the celestial sphere is defined as the angular height 

above the observer’s horizon (taking the shortest angular distance, that is, from the object 
to the point on the horizon directly underneath it).

 The point directly over an observer’s head, known as the zenith, has the maximum 

possible altitude of 900, while the horizon has an altitude of 00, as illustrated above.
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 Azimuth is  defined along the horizon, and is measured starting from North, heading 

towards the East, and ending at the point directly below the celestial object of interest. For 

example, an object due East has  an azimuth of 900, while a point due South has an azi-

muth of 1800.

 The illustration shows a hypothetical star with an altitude of 600, which is 2/3 of the 
way from the horizon to the zenith. The star is to the south-east (half-way between east and 

south), and therefore has an azimuth of 1350 (half-way between azimuths 900 and 1800).

 Project preparations

 Your hands and fingers can be used to make rough esti-

mates of the angular positions of objects  on the celestial sphere, 

and the angular separation between objects: 

 For example, if you stretch your arm in front of you, and 
sight along your arm with one eye, the angle “subtended” by your 

fist will be about 100.

As part of your project report, calibrate the 100 fist rule 

for yourself, as follows. 
★Make a fist with your knuckles  running up-and-down verti-

cally. Hold your fully-stretched arm out in front of you, and sight 

along your arm with one eye while it is held horizontally (ask a 

friend to verify that your arm is horizontal). 

★Then place your other first on top of the first, and continue 

stacking fist-over-fist, until your line of sight is vertical. 

★Be sure to stack one fist against the thumb-knuckle of the 

other fist, with the knuckle “sticking out” as illustrated to the right. 
★Count how many fists were stacked (not counting the first 

“horizontal” fist, which is at 00). Since these covered 900, deduce 

the angle subtended by a single fist. 

★Detail the results in your project report.

 Observation Details

 Begin your observations by testing some of the angle 

guides illustrated on the right on the actual night-time sky. We’ll 

use the known angular separation between some stars in Orion, 

and the nearby constellation of Gemini (just to the East of Orion). 

(i) Start with the 50 “three-finger rule:” the angle subtended 

from the top of the index finger to the bottom of the ring fin-

ger (which is next to the little finger) is about 50. Test this  rule using the “twin” stars 
Castor and Pollux in the constellation of Gemini (see 365 Starry Nights, February 

21-22), which are separated by 4.50. How many fingers “fit” in between the two 

Taken from 
365 Starry Nights

©1982 Prentice-Hall
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stars? Try to estimate to within a half-finger or so. Always remember to sight along 

your arm with one eye.

(ii) Test the 100-rule.by sighting your fist between Orion’s left shoulder (the star Betel-

guese) and the left star in Orion’s belt (the star Alnitak), whose separation is very 

close to 100 (see 365 Starry Nights, January 5). How closely does the 100-rule agree 

with observations using your own fingers?

(iii) Test the 150-rule. the space between the little finger and the index finger, when fully 

spread out, subtends an angle of about 150. Test this rule against the angular sepa-

ration between the star in Orion’s right shoulder, called Bellatrix, and the blue-giant 
star Rigel in the right knee, which is 14.80 (see 365 Starry Nights, January 5). How 

closely does the 150-rule agree with observations using your own fingers?

(iv) Test the “pinky” rule: it subtends  an angle of about 1/2 degree. An interesting ex-

ample is provided by the Full Moon, which subtends an angle of about 1/2 degree. It 

will likely surprise you that you can can block a Full Moon with your pinkie! The 

Moon generally gives the impression of subtending a much larger angle, because it 

is  usually the largest object in the sky, with nothing else to set its scale (for this rea-
son photographs of the Moon, without appreciable magnification, are usually disap-

pointing). If the Moon is not visible, you can also test the pinky rule with the stars in 

the head of Orion, as illustrated in 365 Starry Nights (January 6). Recognize that the 

Full Moon could easily fit inside the small region occupied by Orion’s head!

(v) A popular and interesting example of two stars separated by a small angle is the 

double star Mizar and Alcor, located in the handle of the Big Dipper, which are de-

scribed in the May 14-15 excerpt of 365 Starry Nights. These stars are separated by 
only 2/10o, about half the width of a pinkie. See if you can verify the small angular 

separation of Mizar & Alcor for yourself. This pair is  also interesting to observe be-

cause, in addition to being so close, they are also very different in brightness: Mizar 

is magnitude 2.2 while Alcor is mag 3.9, a factor of almost five in brightness.

(vi) The final part of this project is to use the finger and fist rules, either alone or in 

combination (for example, by “stacking” fists or fingers), to estimate the angular posi-

tions (altitude and azimuth) of the following objects:

★Polaris (note that the azimuth of the celestial pole is defined as 00).

★Betelgeuse (the red star in the left shoulder of Orion) 

★Rigel (the blue star in the right knee) 

(...continued overleaf)
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 Notes: 

★When measuring altitude, say by stacking fists, ask a friend to make sure that your 

first outstretched arm and fist are horizontal. Do not count the “first” fist, since it is at zero 

altitude. 

★When stacking fists, be sure to stack one fist against the thumb-knuckle of the 
other fist (the knuckle should “stick out” as illustrated on pg. APRO-II-2).

★Be sure to record the exact time of your observations, since the angular coordi-

nates of all celestial objects will change with time (except Polaris).

★To determine the azimuth, you will need to know the direction of North. Use a 

compass, or a known landmark, or Polaris itself (if you can find it without knowing which 
way is North!).

★Do not forget to “calibrate” the angle subtended by your fist, according to the pro-

cedure under Project Preparations on the second page of this  script, and describe the re-

sults in your project report.

★You may be surprised to learn that the angle subtended by fingers and fists are the 
same for most people, whether they have bigger or smaller bodies. This is  because the 

proportions of the body plan are roughly the same for most people, regardless of their 

overall size.

 Notes on Polaris measurements: 

★Take several measurements of the altitude of Polaris and average the results. (See 

Physics Lab  I, Triangulation & Scientific Error Analysis, for a discussion of scientific uncer-

tainties.) Estimate the scientific uncertainty in your angular measurement of the altitude of 
Polaris. Be sure to consider the source(s) of “systematic” uncertainty, which may be larger 

than the “statistical” uncertainty.

★Aim for the most accurate measurement possible of the altitude of Polaris. You 

may be able to manage a degree of precision or better by using a combination of fists and 

fingers (for example, the pinkie subtends an angle of about 1/20 , while the tip of one finger 
subtends about 10).

★We see in class that the altitude of Polaris closely approximates the observer’s lati-

tude. How well do your measurements agree with the latitude of Vancouver? How signifi-

cant is the agreement or disagreement, in the light of the scientific uncertainty in your 

measurement?
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  I I I

O B S E R V A T I O N  O F  V A R I A B L E  S T A R  A L G O L

 Goals 

 The goals of this project are two-fold:

★Measure and record the variable magnitudes of the eclipsing-binary star Algol.

★Gather together observations from the entire class, which may allows us as a group 

to plot a light curve of the magnitude data, near the deepest part of the eclipse.

 Observation Plan

★Observations should be done in two parts, on two separate evenings: 

1) Observe Algol on at least one night when there is no eclipse; 

2) Observe Algol on a night when there is an eclipse, ideally roughly every 20 min-
utes, over about two hours around the time of a minimum

★Eclipses of Algol can only be seen on specific dates, within a few hours of the 

deepest part of the eclipse (called the minimum). Dates and times of suitable min-

ima in the spring term of 2008 are:


 ★  Jan. 9 @ 9:42 PM
 ★  Jan. 12 @ 6:31 PM



 ★  Jan. 29 @ 11:27 PM 
 ★  Feb. 1 @ 8:16 PM 
 ★  Feb. 4 @ 5:06 PM


 ★  Feb. 21 @ 10:02 PM
 ★  Feb. 24 @ 6:51 PM


 ★  Mar. 13 @ 00:47 AM 
 ★  Mar. 15 @ 9:36 PM 

 ★  Apr. 4 @ 11:21 PM 
 ★  Apr. 7 @ 8:10 PM 

 Background

 Algol (β Persei) is an eclipsing-binary star system in the constellation of Perseus. 

Eclipsing binaries are two stars  in orbit around each other, with each star periodically pass-
ing in front of the other, along the line of sight from Earth. These star systems will be dis-

cussed in class, based on Chapter 10.7 of our textbook, Astronomy: A Beginner’s Guide, 

see Figure 10.18 (5th edition).

 Figure 1 on the next page shows a “light curve” for a typical eclipsing binary, taken 

from another textbook (The Cosmic Perspective by Bennett et al.). A light curve plots  the 
combined brightness of the star system as a function of time; the timing details  given in Fig. 

1 provide rough guides to the actual light curve for Algol. Normally, Algol is magnitude 2.1, 

easily bright enough to be seen in city skies. However, during the deepest part of the 

eclipse, its magnitude drops to about 3.4 (a change by a factor of about 2.5(3.4-2.1) ≈ 3.3). Al-

gol is by far the most prominent variable star that is visible to the naked-eye.
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          © 2005 Pearson Education, Inc., publishing as Addison Wesley       FIG. 1

Deepest part 
of eclipse 
≈ 1.5 hrs

either side 
of minimum

Little noticeable change except within
≈ 3 hrs either side of minimum

Entire Algol cycle takes ≈ 3 days

Minimum →

 In the case of Algol we can't see the two stars separately (“A” and “B” in Fig.1), even 
in a large telescope, because they are so close together, and at a tremendous distance; 

instead we see what looks  like a single star (many other binary stars can be seen sepa-

rately, or “split,” in a telescope — we will look at some examples during the star nights). We 

can however infer that this is  a binary system, from the shape of the light curve; more direct 

evidence for the binary nature comes from spectroscopy, as we will discuss in class. 

 The biggest drop in the brightness of Algol takes place when the smaller brighter 

star is  eclipsed by its  larger and fainter companion; in addition to this primary minimum, 

there is also a secondary minimum, when a portion of the larger star is eclipsed by the 

smaller one. In the case of Algol the secondary minimum is not very noticeable to the na-

ked eye.

 Algol derives from the Arabic for “The Ghoul,” revealing that its  peculiar properties 

were known to the ancients. According to the ancient Greek legend, the hero Perseus slew 

the Medusa, a monster whose gaze turned people to stone, using his  shield to look only at 

the Medusa’s reflection. As imagined on the sky, Perseus is holding his sword in one hand, 

while grasping the Medusa’s severed head with the other, the “evil eye” periodically blinking 
as a continuing reminder of the monster’s malevolence. 

 Although the period of the binary star orbit (and hence of the entire light curve) is  

about three days, there is little noticeable change in Algol’s brightness except within about 

three hours either before or after the deepest part of the eclipse. The change is  brightness 

is  most noticeable within a very short short time-span of about 1.5 hours, either before or 
after the minimum, and the drop in brightness in that interval is quite striking.

 Observation of variable stars  is a popular past-time of amateur astronomers. For ex-

ample, some variable stars change brightness irregularly, due to instabilities in the star’s 

internal processes, or to accretion of matter from a companion star, and careful observa-
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tions of their light-curves  can yield useful information about such processes (see the web 

site of the American Association of Variable Star Observers, http://www.aavso.org/).


 Preparations
 This  project may be a little more challenging that the others, for two reasons. First, 

while Algol is not a faint star, nether is  it exceptionally bright, even in its  “normal” state 

(when it is about as bright as Polaris), and it is in a very unremarkable part of the sky, with 

few bright star patterns nearby. Second, Algol shows little change except during the deep-

est part of the eclipse, which lasts for only a few hours, and which happens only once 
roughly every three days. Thus advance preparation and planning is crucial for a success-

ful observation of an eclipse. On the other hand, your effort will be amply rewarded when 

you witness the drama of the eclipse for yourself, informed by your understanding of the 

physics of this  distant star system, seen across a gulf of space and time which spans a dis-

tance of some one-hundred light-years, and with an eclipse having actually taken place al-
most one hundred years before you observe it.

 Figure 2 on the last page of this script is a star chart of a region of the sky to the 

West on Feb. 28 2007 at 8PM (this view of the constellations will be identical any evening 

in early winter of any year). 

 Algol is  indicated by the open circle in Fig. 2. Compare this chart with the plani-
sphere, where Algol is the last “dot” in the constellation line just above the “E” in “PER-

SEUS.” Read the November & December sky maps and highlights in the excerpts from 365 

Starry Nights for helpful background on this part of the sky.

 Familiar nearby regions of the sky that help in locating Algol include the constellation 

of Cassiopeia, which is very prominent by virtue of its  “W” shape (see 365 Starry Nights, 
November 3-4), and the constellation of Auriga, whose brightest star, Capella (α Aur), is 

part of the Winter Hexagon (Auriga is described in 365 Starry Nights, January 29-30).

 A common trick used by amateur astronomers to locate objects in an unremarkable 

or unfamiliar part of the sky is  to start from a relatively nearby constellation or star pattern 

that is more recognizable. The trick is  to use a star chart to identify a pair of familiar stars 
that can be used to “point” to the object in question. 

 Figure 2 includes a useful pointer for locating Algol, using two stars in Cassiopeia: 

draw an imaginary line from β Cas (“beta,” the 2nd brightest star in the constellation, at 

magnitude 2.3) through nearby η Cas (“eta,” not very prominent at magnitude 3.5), and 

continue for about 25o to reach Algol.

 Figure 2 also gives the magnitudes  of several comparison stars near Algol. Note that 

decimal points in the magnitudes are omitted on the star chart, so as to avoid confusing the 

decimal with a star. For example, the number “29” next to a star means that it has magni-

tude 2.9.

 There are two particularly useful comparison stars. The first is γ Andromedae 

(“gamma”), which has magnitude 2.1, the same as Algol in its  “normal” state. You will need 
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a “pointer” to properly identify γ And. Once again we can use two stars in Cassiopeia: this 

time, draw an imaginary line from β Cas through nearby α Cas (“alpha,” the brightest star 

in the constellation), and continue for about 20o to reach γ And.


 A second very useful comparison star is  ρ Persei (“rho”), which is only about 20 

south of Algol, and which, at magnitude 3.3, will be only slightly brighter than Algol during 
the deepest part of the eclipse (although the colour contrast may give some people the im-

pression that ρ Persei is a bit fainter than Algol at the minimum).

 Scheduling Issues

 Algol’s brightness does not change much outside a narrow window of a few hours  

around the time of the deepest part of the eclipse. Although there is an eclipse every 2.87 

days, only a few eclipses occur at a convenient time of night (most eclipses occur during 

daylight hours or late at night).

 Convenient eclipses typically occur in pairs about every two weeks. It is therefore 

essential that you plan in advance for those dates and times.

 A very handy resource for planning observations is an on-line calculator provided by 

Sky & Telescope magazine, which computes the times at which Algol reaches its minima:

http://skyandtelescope.com/observing/objects/variablestars/article_108_1.asp

 Sky & Telescope also has a useful on-line article about Algol, see:

http://skyandtelescope.com/observing/objects/variablestars/article_160_1.asp

★Suitable dates  and times of Algol minima for the current semester are given at the 
beginning of this script, under Observation Plan.

 Observation Details

★You should be sure to compare Algol with γ And on a night when there is no 

eclipse, to form a good impression of Algol in its “normal” state. 

★During an eclipse, compare Algol frequently with the comparison stars, especially  

γ And and ρ Per, which together more-or-less “bracket” the entire range of magnitudes. 

★Ideally you should observe Algol every 20 minutes or so within about 1.5 to 2 

hours of a minimum.

★Bear in mind that you can start observing either before the minimum, and follow 

Algol as it progressively gets  fainter, or you can start around the time of the minimum, and 

track Algol as it progressively returns to its normal brightness.

★You may be able to estimate Algol’s brightness to a small fraction of a magnitude 

by making use of all of the comparison in Perseus, Auriga, and Cassiopeia, given in Fig. 2; 

changes as small as  0.1 magnitudes (which represents  a change in brightness of 10%) 

might be noticeable, especially near the minimum of Algol, if you use two comparison stars 

that are close in magnitude, in order to “bracket” the observed brightness of Algol.
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Beware: This chart was drawn using SkyChart III “modern” constellation 

outlines, which may by differ somewhat from the outlines on 

the Edmund Scientific Star and Planet Locator.

FIG. 2
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  I V

M A R S  —  W A N D E R E R  I N  T H E  S K Y

 Goals

★Plot the motion of Mars relative to the background stars, and measure changes in 
its magnitude, over the course of the semester.

 Observation Plan

★Observe Mars at least twice during the term; make the first observation as  early in 

the term as possible, and make your last observation as late in the term as possible. 

 Background

 The “wandering” motion of the planets against the background of fixed stars puzzled 

the ancients. Copernicus’ model of a Sun-centered universe eventually overturned the 

Ptolemaic system, and ushered in the scientific age. However, it was more precise obser-

vational data, due to Tycho Brahe, that proved decisive: both the Ptolemaic and the Coper-
nican systems were inconsistent with this data, and while Copernicus’ model was more 

“elegant,” it was clear to Brahe and his  assistant, Johannes Kepler, that a more accurate 

theory was needed. 

 In this  project you will observe the wandering motion of Mars for yourself. As you 

work through this project, bear in mind that Brahe himself conducted his  observations with 
the naked eye, just as you will do. Recall as well that Brahe’s precise observations of the 

motion of Mars caused Kepler to reject circular orbits for the planets, and ultimately led to 

his “complete reformation in astronomy.” Kepler’s three laws of planetary motion would in 

turn be explained by Newton with his universal laws of gravity and motion, in a unified sci-

entific description of all mechanical phenomena, in the Heavens and on Earth. Hence in 
observing Mars you are, in a sense, retracing the very origins of the scientific revolution!

 A time-lapse movie of the motion of Jupiter and Saturn against the background stars, 

over nearly a full year, can be seen at Astronomy Picture of the Day for December 20 2001:

http://antwrp.gsfc.nasa.gov/apod/ap011220.html.

 Preparations 

 Whether or not a particular planet will “wander” against the background of stars in a 

significant way, in a relatively short period of time, such as a few months, depends  on the 
relative position of the Earth and the planet in their orbits. 

 In order to plan an observation project like this, it is very helpful to use planetarium 

software, such as SkyChart III, in order to decide which planets, if any, are suitable for ob-

servations in a given period. This was one goal of the Astro Computer Lab, which we will 

have done in the second week of class, and where we will have found that Mars provides a 
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spectacular opportunity to view planetary motion in the spring of 2008. Mars is the best 

planet for observing motion against the background stars, since it is the closest outer 

planet, and thus exhibits  the most spectacular changes in position and brightness, while 

being easy to observe. 

 Mars will finish retrograde motion at the end of January, thereafter undergoing very 
rapid prograde motion, moving East relative to the stars  as much as a few degrees each 

week. Over the semester Mars will also noticeably decrease in brightness, by just over two 

full magnitudes, as it crosses from the constellation of Taurus to Gemini.

 You should read the January & February excerpts  of 365 Starry Nights in order to 

familiarize yourself with the stars and constellations in this part of the sky. Of particular im-
portance is Aldebaran (α Tau), the brightest star in the constellation of Taurus the Bull, and 

the “twin” stars in the constellation of Gemini, Castor (α Gem) and Pollux (β Gem). You will 

use these stars to measure the position and magnitude changes of Mars.

 Observations

★Observe Mars at least twice during the term; make your first observation as early 

in the term as possible, and make your last observation as late in the term as possible, in 

order to record the greatest possible change in its position and brightness.

★On each night of observations, carefully measure and record the angle of Mars 

with respect to the star Aldebaran. Consider using Castor and Pollux as well to get the 

most precise measurements possible.

★Also measure the brightness of Mars with respect to Aldebaran. 

★Record each evening of observations in a separate logbook entry. Use a star chart, 
such as the one below, to collectively record all of your position observations.

Vancouver,
April 4 2008, 8PM,
View to South-West
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  V
P E R I O D  O F  T H E  M O O N ’ S  O R B I T

 Goals

★To measure the Moon’s angular position relative to a fixed star or planet, over two 
nights, and deduce the sidereal period of its orbit around the Earth.

Observation Plan 

Observations must be done on two consecutive evenings, and only on nights which 
fall in one of the following intervals:


 ★  Jan.15  to 22                    ★  Feb. 12 to 19                    ★  Mar. 10  to 17

 Background

 The time it takes for the Moon to complete one 3600 orbit around the Earth is  known 
as its sidereal period, because the Moon will return to the same point in the sky relative to a 

star. There is another lunar cycle, of perhaps  greater interest to the inhabitants  of planet 

Earth, which is the cycle related to the Moon’s phase, say from one New Moon to the next; 

the period of that cycle is  known as  the synodic period (from the ancient Greek word for 

“meeting,” as in the “meeting” of Moon and Sun at New Moon).

 The sidereal and synodic periods are different, because the percentage of the lunar 

disk that is  illuminated by the Sun, as  viewed from the Earth, depends  on the relative an-

gles of the three bodies, which is affected by the Earth’s  motion around the Sun, as well as 

the motion of the Moon around the Earth. The geometry is similar to the illustration in Fig-

ure E.7 on page 8 of our textbook (5th edition), and will be discussed in class.

 In this  project you will estimate the Moon’s  sidereal period by measuring its angular 

motion relative to a star or planet. By measuring the change in the Moon’s angular position 

over two days, you can estimate how many days it would take for it to cover a full 3600 rela-

tive to the distant celestial object. (If one was to measure the period of the synodic cycle 

instead, how could that be done?)

 Preparations & Observation Details

 The illustration on the next page shows how the position of the Moon relative to a 
particular star or planet might change from one night to the next. You are to measure the 

angle between the Moon and the same star or planet on two consecutive nights.

 It is  important to find good dates for making these observations, when the Moon is 

up at a reasonable time after sunset, and when it is near a bright star or planet. It is  also 

important that the reference object be as close to the ecliptic as possible (why is that?).

 Try to use the planetarium software yourself to pick good dates: run the software 

animation over a whole month, tracking the motion of the Moon. In spring term 2008 con-

venient reference objects are the Pleiades, Taurus, Gemini, and Mars. The Moon can be 
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seen within about 300 of a bright star or planet in this broad region of the sky, at a decent 

time of night (6-9 PM), during the periods listed above. 
★Avoid making observations within a few days of a Full Moon, since the Moon is 

then so bright that it will tend to overwhelm the much fainter light of the reference object.

★Carefully record the precise time of your observations, and make as accurate a de-

termination of the angle between the Moon and the reference object as possible. Include a 

sketch in your log book.

★Take several measurements of each angle and average the results (see Physics 

Lab I, Triangulation & Scientific Error Analysis, for a discussion of scientific uncertainties). 

✵


 Analysis 

 To compute the sidereal period, let θ be the change in angular position of the Moon 

over the two nights, and let τ be the time elapsed in days between the two observations.

 For example, let’s suppose that in the illustration above the Moon is  50 to the right of 
the reference star at 7:30 PM one night, and to 100 the left at 9:00 PM the next night. Then 

the Moon changed its angular position by θ = 100 + 50 = 150, in an elapsed time τ of 1 day 

plus 1.5 hours, or τ = 1 + (1.5/24) ≈ 1.063 days.

 To find the Moon’s sidereal period, use the proportional relation:

θ

τ
=

360◦

Sidereal Period
,

which implies

Sidereal Period =
360◦

θ
× τ.

 In our hypothetical example, Sidereal Period = 3600 / 150 X 1.063 ≈ 25.5 days.

 Note: In the above example the Moon was to the right of the reference object one 
night, and to the left on the next. It may happen that the Moon is on the same side of the 

reference object on both nights of your observations; in that case, the change in angular 

position of the Moon is given by the difference in the two measured angles. 

 Compare your result with the known sidereal period of 27.3 days. How close is your 

answer, as a percentage difference? 

 For the fullest analysis of your results, estimate the scientific uncertainty in the side-

real period. The uncertainty in the sidereal period, as a percentage error, is the same as the 

percentage error in the measured angle. Don’t forget to include possible sources of sys-

tematic error in the measured angle. Does your estimate of the sidereal period agree with 

the known value, within the scientific errors?
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P H Y S I C S  1 9 0 :  A S T R O  P R O J E C T  V I

P H A S E S  O F  T H E  M O O N

 Goals

★Observe and record the location and phases of the Moon over several weeks.

Observation Plan 

 Observations must be done at about the same hour on three or four evenings (not 

necessarily on consecutive nights), within two weeks following a New Moon.

 In spring term of 2008 New Moon begins on the following dates:

 ★Jan. 8                       ★Feb. 6                       ★Mar. 7

 Note: You will not be able to make useful observations much after Full Moon, since 

the Moon will then rise too late after sunset, hence you should begin the sequence of ob-

servations as close to a New Moon as possible. 

 Background

 Most people know that the Moon’s phases change over the course of a month, but 
remarkably few people know that the Moon shines by reflected sunlight, with its phase de-

termined by its position relative to the Sun and Earth. In this project you will qualitatively 

record the Moon’s location and phase over several weeks, to track these connections for 

yourself. 

 Preparations

 Find a convenient location from which you have a relatively unobstructed view of the

East                                                          South                                                       West

Jan.6 

6 PM
Jan.9 

6 PM
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horizon, facing South, and such that you are able to look to the East (to the left) and to the 

West (to the right). Your view of the horizon should also include some landmarks, such as 

some nearby buildings, power lines, trees, etc. Ideally, there should be landmarks at sev-

eral points on the horizon along the way from East to West.

 Make a sketch of the horizon including the landmarks, with enough space to fill in 
the position of the Moon in the sky, as in the above illustration. Place South in the center, 

and label East and West (use the setting Sun to locate West if you don’t have a compass).

 Observation Details

 Conduct your observations at the same time after sunset each night (about 30 min-

utes to 1 hour after sunset), and from the same location.

 Refer to the note on the previous page about scheduling observations during the two 

weeks following a New Moon.

 Since we want to have some idea of the relative position of the Moon and Sun, it is 

convenient to choose a fixed time that will be within an hour or so of sunset, when the Sun 

is  not too far below the Western horizon. From January to the end of February pick a time 
around 5-6PM, while in March pick a time around 6-7PM.

 Record the position of the Moon, relative to the landmarks on your sketch, during 

each observation. Draw the shape of the Moon, taking care to distinguish between cres-

cent, waxing, and full phases. Also be sure to estimate the Moon’s  altitude. Record the date 
and time on your sketch with each observation of the Moon, similar to the diagram on the 

last page.

 Also estimate the percentage of the lunar disk (the so-called phase) that is illumi-

nated on each observation. Include a table of the observation dates and estimated lunar 

phases (from 0% to 100%) and altitudes in your project report.

 Start making your observations, if possible, within a day or two of a New Moon, and 

record the Moon’s location and phase every few days, up to Full Moon. If the weather is a 

problem, you can try to accumulate observations over several lunar cycles.

 In your project report use your sketches and estimated lunar phases to summarize 

how the positions and phases of the Moon change with time, starting from New Moon. 

 Can you see evidence in your data for the relation between the Moon’s phase and 

its angle from the Sun> How does the Moon’s  altitude change (i.e., always higher later into 

the lunar cycles)?
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  I
T R I A N G U L A T I O N  &

S C I E N T I F I C  E R R O R  A N A L Y S I S

Goals 1. Measure the distance of an object by triangulation.
2. Learn about some aspects of scientific error analysis.

Equipment 1. Calculator, pencil, ruler. [Bring your own, including a calculator.]

2. Laser pointer that turns through an angle and moves along a baseline.

3. Large and small protractors for measuring & plotting laser turn angle..

4. Tape measure for determining the length of the baseline, and (after you 
predict the distance by triangulation!) the “actual” distance to the object

[All equipment is provided at the physics lab, unless otherwise indicated.]

CAUTION: DO NOT LOOK DIRECTLY AT THE LASER

BACKGROUND 

The method of triangulation and its  relation to distance measurements in astronomy, 

by the technique of parallax, are discussed in the first or second weeks of class, and in the 

opening section Exploring the Heavens of our textbook, Astronomy: A Beginner’s Guide.

A detailed set of instructions on how to perform this  experiment is given later in this 

lab script under Procedure. 

Before you begin the experiment you should thoroughly read this background sec-

tion, which gives an introduction to the concepts of scientific error analysis, which is  a major 

theme of this lab. This section also contains  some worked examples that you should go 

through in order to understand the data analysis that you will perform during the lab.

Figure 1 on the next page shows an illustration of a hypothetical triangulation ex-
periment, taken from Fig. E19 on page 17 of our textbook (5th edition). The experiment 

consists of measuring the length of the baseline along which the laser sight is  moved, and 

an angle when the laser is  turned, at one end of the baseline, in order to line up with the 

object whose distance is to be determined.

The distance to the object can be estimated from the measured values of the length 
of the baseline, and the turn angle of the laser. The analysis in this lab is to be done 

graphically, even if you know trigonometry! The graphical analysis technique for the physi-

cal setup in Fig. 1 was discussed in class  using the illustration that is reproduced in Fig. 2 

on the next page.
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The most difficult quantity to measure in this experiment is  the turn angle of the laser 
(see the “interior angle” in Fig. 2). As  you will discover when you perform this experiment, 

the measured value of the angle generally changes each time a person measures it, and 

from person to person. This  means that one cannot trust the result of a single measure-

ment.

All measuring instruments, and the measurement of all scientific quantities, behave 
in this  way. We say there is some uncertainty inherent in all scientific measurements. One 

thinks of the angle for instance as having a definite value, but our instruments and tech-

niques have various limitations, perhaps a wobbly laser sight. (The same is true of the 
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measurement of the baseline length, but this won’t be as noticeable in our experiment as 

the uncertainty in the measurement of the angle.)

It seems reasonable to expect that one can obtain a more accurate result for the an-

gle by combining the individual measurements. The old adage, that “the truth lies in the 

middle,” suggests  that the “best” estimate of the angle might be the measurement with the 
value in the middle or, perhaps, that the best value is the average of all the measurements:

Average =
Sum of the individual values

N = number of measurements
, Eq. (1).

For example, if one measured the angle 4 times, with results of 48.00, 48.75, 52.25 

and 54.00 degrees, then the average angle according to Eq. (1) would be:

Example Average =
48.00 + 48.75 + 52.25 + 54.00

(N = 4)
=

203.00

4
= 50.75◦.

It is unlikely that the average will turn out to be exactly equal to the “true” angle, but 

it is likely to be closer than the individual measurements, which are more “directly” affected 

by limitations in the apparatus and techniques.

For example, if the apparatus wobbles, or “fluctuates,” each time a measurement is 

made, it is reasonable to expect these fluctuations to “average out” when adding up over 
many measurements: sometimes the apparatus will wobble in one direction (resulting say 

in a somewhat larger angle), and sometimes in the opposite direction (giving a somewhat 

smaller angle). 

Since the fluctuations won’t cancel perfectly (in a finite set of measurements), it is 

important to estimate how much uncertainty is  left in the average value, in order to know 
how confident we should be in the result.

We refer to uncertainties like those caused by random wobbles as “statistical” uncer-

tainties. Here is a very rough rule of thumb for estimating the statistical uncertainty: Use 

the difference between the largest individual measurement, and the smallest, in the fol-

lowing approximate formula

“Statistical” Uncertainty in the Average ≈
Largest - Smallest

2 ×
√

N
, Eq. (2).

(The exact formula is known as “the standard deviation of the mean.”) This formula shows 

that the uncertainty will be smaller (that is, the average value will be more accurate) if one 
makes more measurements.

For example, in our hypothetical experiment, the largest measured angle was 54.00 

degrees, and the smallest was 48.00 degrees, so the statistical uncertainty is roughly esti-

mated from Eq. (2) as:

Example Statistical Uncertainty ≈
54.00 − 48.00

2 ×
√

N = 4
=

6.00

2 × 2
= 1.50◦.
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Note that measurement results are reported using the standard notation:

Measured Quantity = Average ± Uncertainty, Eq. (3).

For example, in our hypothetical experiment, we would report the result of the ex-
periment as Measured Angle = 50.75o ± 1.50o.

Discussion: When doing this laboratory experiment we will need to take account of 

one final “fact of life” in scientific error analysis. Most experiments, including this  one, suffer 

from other kinds of uncertainty, which are often much more difficult to reduce than statistical 

uncertainties. For example, in this experiment, the protractor itself is fundamentally limited 
by the size of its markings: our protractor’s markings will limit the precision of the experi-

ment to about 0.25o, no matter how many measurements of the angle are taken! We call 

this  an “instrumental resolution.” Once the statistical error has been reduced below the in-

strumental resolution, by taking a sufficient number of measurements, there is  no point tak-

ing more data! In that case, the only way to do better would be to build a “finer” instrument.
                                                                                                                               

PROCEDURE

Step #1 Measure the baseline along which the laser sight travels. Record the re-

sult on the first line of the data sheet at the end of this lab script.

Step #2 Put the laser sight at one end of the baseline, to make sure the beam hits 

the object “dead on,” with the laser pointing at right angles to the baseline. 

 Then move the laser sight to the other end of the baseline, and turn it until 
the beam hits the object.

Step #3 Use the protractor to measure the interior angle (refer to Fig. 2, which 

shows an example of an interior angle of 52○). This is a crucial step, be-

cause even a relatively small error in the measurement of the angle can 

result in a large error in the estimate of the object’s distance.

 Since the angle is so crucial to the experiment, each partner should 
measure it a few times. Alternate measurements with your partners.

Notes: 1) Place the “tip” of the laser beam precisely at the “zero line” of the pro-

tractor, as illustrated in Fig. 3 on the next page.

 2) One lab partner should hold the laser beam tip at the protractor zero 

line, while verifying that the laser beam hits  the object. Another lab partner 
should read-off the interior angle. 

 3) Do not force yourself to get the same angle each time. Rather, try to get 

the most accurate value each time.Enter the results in the table next page.

 4) Try to measure the angle to an accuracy of 0.25o, “interpolating” be-

tween the protractor markings, as discussed in tutorial. 

 5) Try to record your values independently of your partners. First record 

your measurements, and then record your partners’ values.
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P A R T N E R  # 1 P A R T N E R  # 2 P A R T N E R  # 3

Measurement 1

Measurement 2

Average values                 ±                 ±                 ±

Overall Average             ±

Step #4 Compute the average angle, using Eq. (1), for each individual lab part-

ner, and record the results in the table. 

Note:  Round all of your calculations to the nearest 0.25o.

Step #5 Use Eq. (2) to compute the statistical uncertainty in the average value 

for each lab partner. Enter the results  in the table, using the standard nota-

tion of Eq. (3).

Step #6  Now compute an overall average angle, using Eq. (1), combining all of 
your measured angle values and those of your partners. Then use Eq. (2) 

to compute the statistical uncertainty in the overall average. 

 Enter the result for the overall average with its  error in the last row of the 

table, and in the second line of the worksheet at the end of the script.

Note: If the result of any statistical uncertainty calculation is under 0.25o, use the 
instrumental resolution of ± 0.25o as  the actual uncertainty instead (see 

the discussion in the Background section, below Eq. (3)).
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Step #7 Work through the graphical analysis on the worksheet, using your 

groups’ average value for the interior angle, to arrive at your group’s “av-

erage” estimate of the distance to the object. Use a protractor to draw a 

scaled triangle on the grid in the worksheet.

Step #8 Draw the scaled triangle a second time, now using an angle at the 
“high” end of the uncertainty in the average interior angle. 

 (In the hypothetical experiment described in the Background section, the 

average angle was 52.25o, and the angle at the “high end” of the uncer-

tainty range was 50.75o + 1.50o = 52.25o, as illustrated in Fig. 4).

 Rework the graph for the distance to the object using the “high end” of 
the interior angle. Read off the “plus” uncertainty in the distance, as  in 

Fig. 4, and enter the value in the worksheet.

“Plus” Uncertainty

in Distance

52.25o

Fig. 4

50.75o

Step #9 Complete the rest of the worksheet.
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Measured Baseline                    = _______________ cm.

Overall Average Interior Angle =                ±             degrees.

From these measurements plot a scaled version of the triangle 
on the grid (compare with Figs. 2 and 4).

Use a scale of 1 square on grid = 10 cm distance.

Compute the # of grid squares for the baseline as follows:

Baseline = _________cm physical distance / (10 cm / square) 

               = _________ grid squares

Draw this as horizontal line on the grid starting at the bottom.

Then use the protractor that was provided to you to complete 
the triangle.

Read off the distance to the object in grid squares, and convert 
to the physical distance of the object, as follows:

Predicted Object Distance  =                 ±            grid squares

                                               x 10 cm / square

                                               =                ±            cm.

Use the tape measure to measure the “actual” distance to 
the object: 

Measured Object Distance  = ________________ cm.

Comment on the difference between the predicted and meas-

ured distances (first, compute a percentage difference). How 

significant is the difference, in light of the estimated uncertainty 

in the measured interior angle? Are there other experimental 
uncertainties, and if so, how important are they? What about 

an uncertainty in reading off grid squares on the graph? 

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________(use other side of sheet if needed)
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  I I

N E W T O N I A N  P R O J E C T I L E 

(with thanks to Mehrdad Rastan & Neil Alberding for material from the 
SFU Physics 100 Open Lab Project)

Goals Study parabolic motion of a projectile, as an illustration of Newton’s  laws 

of gravity and motion.

Equipment 1. Projectile launcher & ball; 2. Plastic hoops; 3. Paper and carbon paper.

What to do  Analyze the trajectory of a ball fired from a projectile launcher. You will 

predict the vertical positions  of four plastic hoops, to be placed at evenly-

spaced positions  along the trajectory, such that when you launch the ball it 
will pass through all the hoops.

How to do it The launcher is clamped to your bench (see figure 1). For horizontal 

launch, the launcher’s plumb bob should hang over the zero degree mark.

Caution ▶ Wear Safety Glasses 

 ▶ Don’t stick your finger into the Launcher. Use the aluminum push-

rod to load the ball.

▶ DO NOT use your finger. Place the steel ball in the barrel and push it 

down with the aluminum push-rod until the trigger catches the piston then 

push the ball again until you hear a second click; the launcher is  now set 
at the medium range. Use the second setting. Launch the ball by pulling 

up on the string.

MINI LAUNCHER  
WEAR •SAFETY 

DON'T  

Figure 1: Horizontal launch

Procedure:    #1. Record where the ball hits the ground, when fired by the launcher. To 

do this, tape a piece of paper on the floor, then tape a piece of carbon paper on top of the 
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paper. Fire the ball so that it marks the paper at the point of impact. Use the other plumb 

bob (long one) to find and mark the point on the floor that is directly below the release point 

of the ball (this is marked by a cross at the side of the launcher).

#2. Measure the horizontal distance that the ball travels, and the vertical distance 

that the ball drops, and record the results in the following lines, and in the table below.

 Horizontal distance h from launcher to point of impact on the floor: 

h = ____________(m).

 Vertical “drop” distance d from the launcher to the floor:

d =  ___________(m).

 #3. As we discussed in tutorial the trajectory is a simple parabola. In this case, when 

the particle has travelled a horizontal distance x, it has dropped a distance y, given by 

                y = c x2,                Eq. (1),

where c is a constant. In the case of the final point on the trajectory, we have

d = c h2

hence the constant c is given by:   c = d /h2 =_____________ / meter.

 Compute the value of c in your experiment, and enter the result the above line.

 #4. Divide the horizontal distance between the end of the launcher and the point of 

impact into five equal intervals. Record the values of these horizontal positions in the table.

#5 Compute the vertical drop at each horizontal position, using the general parab-

ola formula Eq.(1) above, and using your value for the constant c, and record the results in 

the table.

impact 
point

position 
1 2 3 4launcher 

Figure out how far the ball 
drops in each interval. 
Put the hoops there.

x = horizontal distance y = vertical drop

Launcher 0 m 0 m

Position 1

Position 2

Position 3

Position 4

Impact Position       h =        d =

#6. Measure the position for the first hoop (position 1) and attach it to the board. 

Then launch the ball through the hoop. If the ball misses, re-measure the position 
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(also re-check your calculations!) and make the necessary adjustments. Now that the first 

hoop is in place, continue with the second hoop and so on.

 #7. When all the hoops are in the correct positions, demonstrate a successful 

launch to your instructor or TA.

 #8. Graph your results of the vertical drop distance versus the horizontal distance of 

the hoop positions and impact position on the following graph paper.

0

0.2

0.4

0.6

0.8

1.0

0 0.2 0.4 0.6 0.8 1.0 1.2 1.4 1.6 1.8 2.0

←
 V

er
tic

al
 d

ro
p 

(m
)

Horizontal distance (m)


 #9. Draw as  smooth a line as possible through the data points  in your graph. How 

well does the shape of your curve agree with expectations? _________________________

________________________________________________________________________

________________________________________________________________________

Chicago’s Buckingham Fountain©Jim Tardio (www.jimtardio.com) 
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  I I I

N E W T O N I A N  W H I R L I G I G

(with thanks to Neil Alberding for material from the 
SFU Physics 100 Open Lab Project)

Goals 1. Study circular motion, including the relationship between circular accel-
eration and the speed and radius of the circular orbit.

 2. Measure the acceleration due to gravity using circular motion.

Equipment 1. Glass or plastic rod about 15 cm long and about 10 mm in diameter. 

 2. String about 1 m in length, and an alligator clip.

 3. Four tennis balls, a meter stick, and a stop watch.

Introduction An object accelerates when moving in a circle, even if its speed is con-

stant. Mathematically, acceleration characterizes any change in the velocity, either in its 

magnitude (speed), or in its direction (or both). Physically, we are familiar with the accelera-

tion associated with circular motion: we know that we must exert a force on a ball moving in 
a circle at the end of a string, by pulling on the string, in order to prevent the ball from flying 

off on a tangent. We also routinely experience circular acceleration whenever we execute a 

turn in a moving vehicle. 

 To explore circular motion in this lab, we hang three tennis balls at one 

end of a string, and put another ball at the other end, with the string running through a glass 
tube, as shown in Fig. 1 below. We shake the tube back and forth, in such a way as to 

make the single tennis ball spin in a circle of some radius R. In this  case, the force F that is 

required to accelerate the spinning ball is provided by the hanging weight of three balls.

m

 

m

weight = 3 mg

clip to mark string length

R

F

string passes through hollow tube

Fig. 1
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Math Sidebar: (This  mathematical interlude is  optional: if you would rather avoid this 
math, you can take Eqs. (4) & (5) below for granted, and skip to Procedure!) 

 In class we saw that the circular acceleration acircular of an object is deter-
mined by its speed v and circle radius R (we consider “uniform” or constant speed):

acircular =
v2

R
, Eq. (1)

(see also Chaisson & McMillan, Astronomy: A Beginner’s Guide, “More Precisely” 1-1, on 
pg. 39 of the 5th edition). We can understand the qualitative dependence of the accelera-
tion on the speed and radius intuitively, since we know from experience that the accelera-
tion increases when we move in faster and/or tighter turns.

 In our analysis of this experiment we also use the relation between the 
speed v of the circular motion, the radius R, and the time T that it takes to complete one 
revolution (T =  period of the circular motion):

v = vcircular =
2πR

T
, Eq. (2).

 Our goal is to measure the acceleration g due to gravity. The analysis  of 
the experimental setup goes as follows. We apply Newton’s 2nd law, F = ma, to the accel-
erated motion of the spinning tennis ball, where the force F acting on the ball is provided by 
the hanging weight of three balls: 

3 /mg = weight = F = /macircular, Eq. (3).

Note how the tennis ball mass m cancels on the two sides. We then plug in the expression 
Eq. (1) for the circular acceleration, and use Eq. (2) to substitute for the speed. For the pur-
poses of analyzing the data in this experiment, the resulting expression is conveniently writ-
ten in the form

↑ slope

R = (3g/4π2) × T 2, Eq. (4).


 We will measure the period T of the ball’s  motion for several different radii 
R; we will then plot the results as graph of R versus  T 2, read off the slope, and then calcu-
late g from Eq. (4), which gives

g = (4π2/ 3) × slope , Eq. (5).

Procedure: #1. Set the radius R of the orbit of the single tennis ball to one of the val-
ues assigned in the table on the next page. To do this, use the meter stick to measure the 
distance from the top of the glass tube, to the centre of the tennis ball, as seen in the figure. 
Use the alligator clip to pinch the string just below the bottom of the tube (leaving a small 
gap of about 1 cm between the alligator clip and the bottom of the glass tube).

 #2. Have one lab partner shake the glass tube back and forth in such a 
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way as to make the single tennis ball go around in a circle. Try to get the ball to go around 
at a constant speed. Also make sure that the alligator clip does not touch the bottom of the 
tube, or else the clip will add an extra accelerating force to the spinning ball. 

  Practice getting a steady motion of the spinning ball, while ensuring 
that there is no contact of the alligator clip with the tube, before going on to the next step.

 #3. Have another lab partner use the stop watch to time 10 full revolutions 
of the spinning ball, and enter the result in the table under the column 10T (timing multiple 
revolutions, instead of a single period, produces a more accurate estimate of T).

 #4. Repeat the measurements for each R. Then fill in the rest of the table, 
and plot the results in the graph of R versus T 2.

R  ( m ) 1 0 T  ( s e c ) T  ( s e c ) T 2  ( s e c 2 )

0.2

0.3

0.4

0.5

 #5. Draw a straight line which runs as closely as possible through the data 
points on the graph. It won’t be possible to perfectly fit a line through all the data points, 
since the data won’t be perfect, due to scientific uncertainties. You should aim instead for 
the “best fit”, the line that minimizes the spread of the data around the line.

0

0.1

0.2

0.3

0.4

0.5

0.6

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
T 2 (sec2)

R (m)

 #6. Compute the slope of the best-fit straight line:

slope =
rise

run
=

m

sec2
= m/sec

2
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 #7. Use Eq. (5) to compute your estimate of g from your value of the slope 
in the last step:

 g =                  m/sec2

 #8. How well does your measured value of g agree with the known value 

g = 9.81 m/sec2? Quote a percentage difference. 
       How can you use your plot of R versus T2 to estimate the scientific un-

certainty in your measured value of g? Try to make a quantitative estimate of the accuracy 

of your result Hint: How much uncertainty is  there in the slope of the best fit line due to the 

“scatter” in the data?

 ___________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  I V

P U L S E S ,  R I P P L E S  A N D  W A V E S

(with thanks to Neil Alberding for material from the 
SFU Physics 100 Open Lab Project)

Goals You have seen various kinds of waves in everyday life. In this experiment you will 

conduct a scientific study of some basic wave properties, including wave propa-
gation, the frequency-wavelength relation, parabolic reflectors, and diffraction.

Equipment 1. Slinkies;  2. Metronome;  3. Tape Measure;  4. Ripple Tank;  

5. Parabolic reflector;  6. Barriers.

I. Pulse speed
 While your partner holds one end of a coiled spring on a smooth floor, pull on the 

other end until the spring is  stretched to a length of about 10 metres. With a little practice 

you will learn to generate a single, short, easily observed pulse. 

1. Carefully monitor the pulse as it moves along the spring.

Does its shape change by much (e.g. smaller as it moves)?____________________

Does its speed change by much (e.g. faster as it moves)?_____________________

2. Now shake some pulses of different sizes  and shapes. If you have two slinkies side-

by-side, compare the speeds of two differently sized pulses, by starting a small pulse 

in one at the same time as a large pulse in the other. Does the speed depend on the 

size of the pulse (e.g. does one pulse “win” a race by a substantial margin, if so 
which one)? _________________________________________________________

3. Change the tension in one slinky by gathering up 15 to 20 coils in your hand. Com-

pare the pulse in the tense slinky with that in the relaxed one. Does tension have a 

significant effect on the speed of the pulse? If so, how? _______________________

___________________________________________________________________

II. Wavelength and Period
 In this part of the lab you will estimate how the wavelength in a slinky changes, when 
its frequency of vibration is  doubled (keeping its tension fixed). That is, you will measure 

the wavelength twice, shaking the slinky at two different rates, one shaking-rate about twice 

as fast as the other. 

First, predict how you expect the wavelength of the slinky at the higher frequency will 

compare with the wavelength at the lower frequency? Explain your prediction!
__________________________________________________________________

___________________________________________________________________
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To measure the wavelengths, follow these instructions:

1. Stick a long stretch of tape on the floor to serve as a reference line. Shake the end 

of the slinky in a symmetrical way, back and forth with equal amplitude on either side 

of the reference line, as best you can (see Fig. 1 below).

2. One lab partner should shake the slinky at a steady rate, while another partner 
should try to estimate the wavelength. Use a metronome to time the vibrations.

3. The pattern that is  generated in a medium with one or more fixed ends is known as a 

standing wave. In a standing wave there are points along the wave that do not vi-

brate: these points are called nodes. The nodes can be identified by locating points 

on the slinky that stay close to the reference line (see Fig. 1).

4. The distance from one node to the next is related to the wavelength of the standing 

wave according to (see Fig. 1):

Wavelength (λ) = 2 x distance from one node to the next.

5. Measure the distance between adjacent nodes while shaking the slinky at the same 

frequency as the metronome (set it to 200 beats/minute). One node is  located at the 

end of the spring which is fixed in place: measure the distance between the fixed 
end of the spring and the next node beyond the fixed point.

Make a second wavelength measurement, now shaking the slinky twice as fast 

(“double time”) compared to the metronome. Enter your results below.

• Wavelength at metronome frequency  _____________ (cm).

• Wavelength at double the frequency   _____________ (cm).

6. How well do the measured wavelengths agree with your predictions? Take into ac-

count the difficulty of shaking the slinky at frequencies that are exactly a factor of two 

different, and the difficulty in locating the nodes.

__________________________________________________________________

___________________________________________________________________

___________________________________________________________________

Nodes

λ / 2
λ 

 Fig.1
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III. Passage of a pulse from one medium to another
 We will now investigate the passage of waves from one medium to another. A famil-
iar example is when an electromagnetic wave (light!) traveling through one medium, such 

as air, enters another, such as  a pool of water. We will study this phenomenon by tying-

together two coil springs in which waves travel with different speeds, as in Fig. 2. 

       Fig. 2
Send a pulse first in one direction and then in the other. What happens when a pulse 
reaches the junction between the springs (e.g. does a pulse get reflected back, does a 

pulse propagate into the second spring, does the shape change, etc.)? ________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

IV. The Ripple Tank

Another device for studying waves is a ripple tank. It has the advantage over the coiled 
spring in that pulses are not restricted to a line.

1. Set up: The ripple tank should be set up over a white screen with a light source 

above it. A clear light bulb with the filament oriented vertically gives the sharpest im-

ages. Water should fill the tank to a depth of 1/2 to 3/4 cm. Verify that the ripple tank 

is  level by checking the depth at all four corners. The sponge dampers along the pe-
rimeter of the tank are to reduce reflections from the sides. They should be wet.

2. To start off, dip your finger tip in the tank. 

What is the shape of the pulse you see on the screen? ______________________

Is the speed of the pulse the same in all directions? _________________________

3. Generate straight pulses in the ripple tank by rolling a dowel (round stick) through 
a fraction of a revolution in the water. Place your hand flat on top of the rod and then 

move it forward about a centimetre. Practice making such pulses until you get sharp, 

bright images on the screen. If the dowel extends all the way across  the tank, the 

pulses should remain fairly straight as they travel. If the dowel is shorter, you may 

see some curvature of the ends of the pulses. Do the pulses remain straight as  they 
move along the tank? _________________________________________________

4. Reflection: Place a straight barrier in the tank and generate pulses  that strike it 

“dead on” (at an “angle of incidence” of 0°). You can build a straight barrier out of 
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four paraffin blocks. Reflect pulses  at different angles of incidence. How does the 

angle of reflection compare with the angle of incidence? This  is an illustration of the 

so-called “law of reflection.”

___________________________________________________________________

___________________________________________________________________

5. Parabolic reflector

Place a parabolic reflector in the tank and send a straight pulse towards  it. Find the 
orientation in which the reflection of the straight pulse converges at one point. This 

point is  the focal point of the parabolic reflector. Using the box below, sketch how 

you oriented the reflector with respect to the straight pulse to focus it. 

Mark this  focal point on the screen with a coin or similar object. Dip you finger tip into 

the water over that point and describe the wave the emerges after reflecting from the 
parabolic reflector. Can you change the direction of the reflected pulse by changing 

the place where you dip your finger?

___________________________________________________________________

__________________________________________________________________

6. Pulses passing through an aperture

 Arrange four paraffin blocks to form a barrier with a small hole in the middle. Send a 

straight pulse towards this barrier and draw what emerges after the pulse passes through 

the hole. Try varying the size of the hole. Sketch the pattern you observe in Fig. 3 below. 

This illustrates the phenomenon of diffraction.

                      Fig. 3
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  V

A T O M S  &  L I G H T :  T H R E E  K I N D S  O F 
S P E C T R A

Goals 

 In this lab you will observe the visible radiation, or spectra, produced by a variety of 
sources, which together span the three categories of spectra that we discuss in class in 

some detail: i) the continuous spectrum produced by an ordinary incandescent filament; ii) 

the emission spectra produced by three different “mystery” gases, whose compositions will 

only be revealed at the end of the experiment; and iii) the absorption spectra in the Sun’s 

light. You will conduct a “spectroscopic analysis” to identify the mystery gases, by compar-
ing your observations  of their emission spectra with a standard laboratory reference of the 

spectra of many different elements.

Equipment 

 1. Diffraction-grating and prism spectrometers;  2. “Mystery gas” discharge tubes; 

 3. Wall chart of the spectral lines of various elements.

Background

 These experiments will be mostly done with a small diffraction-grating spectrometer, 

which uses a plastic sheet (or grating) with many thousands of parallel groves. The grating 

reinforces the tendency of light to “diffract” (or bend) when going through an opening, caus-

ing light of different wavelengths to emerge at different angles: this enables the identifica-

tion of the wavelength of a particular colour of light from the diffraction angle. 

 You will also examine how another spectrometer works, using a prism instead of a dif-

fraction grating; the prism causes light of different colours to refract at different angles.

Activity 1: Incandescent filament

 Follow the TAs  instructions to view the filament through the plastic diffraction-grating 

spectrometer. Look at the filament through the viewing hole in the spectrometer: inside you 

will see a continuous spectrum of colours, and above the spectrum you will find a wave-

length scale in nanometers (nm).
 Measure and record the wavelength spread of each colour in the following table.

(units: nm) R E D O R A N G E Y E L L O W G R E E N B L U E V I O L E T

From:

To:

Three kinds of spectra                                          ©2008 Simon Fraser University                                               PLAB-V-1



Activity 2: Examine a spectrometer

 To get an idea of how the spectrometer you are using works, examine the large spec-
trometer on your lab bench, built from components as in the following illustration.

Optical bench

Slit mask

Slit plate

Prism

Scale

 This  spectrometer uses an “optical bench,” a track along which various components 

can be fixed. The figure shows an incandescent light source at one end.

 Across the middle of the optical bench is a scale, which has position markings, and a 
small slit in the middle through which light from the source can pass. At the other end of the 

track is a prism, which is  used here in place of a diffraction grating, to bend the light from 

the source; a slit mask is placed in front of the prism to help collimate the light.

 Look back through the prism towards various sources (including the “mystery gas” 

discharge tubes), to view their spectra against the background provided by the scale.

 We are not going to “calibrate” this spectrometer (which means to convert the posi-

tions of spectral lines as viewed on the scale to their wavelengths in nm). We’ll use the 

already-calibrated plastic spectrometer for the remaining activities.

Activity 3: Emission spectra of three “mystery” gases

 There are three tubes  containing “mystery gases.” An electric voltage applied to the 

tube induces electric discharges in the gas; these cause electrons  in the atoms to jump to 

higher-energy atomic levels, after which they make transitions to lower levels, with the re-
lease of radiation at specific wavelengths characteristic of each gas. 

 Make a rough sketch showing the placement of some of the brighter lines in each 

spectrum, in the table on the next page, and write down with each line the approximate 

wavelength. Represent the brighter spectral lines with thicker lines in your drawing. 

 Compare your observations of the three spectra with the standard chart of spectra on 
the wall of the laboratory, and try to identify the three mystery gases.

 Note: Beware that the wall chart may show the colours in an orientation opposite to 

that in the spectrometer (i.e. Violet may be on the left on the wall chart, instead of Red).
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(units: nm) R E D O R A N G E Y E L L O W G R E E N B L U E V I O L E T

Gas A

Gas B

Gas C

 Write your spectral-ID of the gases in the following table. Then ask the TA what they 

really are. How did you do? (Remember, this is a friendly competition, so no worries if you 

are wrong!)

Y O U R  I D  O F  T H E  G A S A C T U A L  I D

Gas A

Gas B

Gas C

Activity 4: Absorption spectrum of the Sun

 The absorption spectrum of the Sun can be seen by looking at the light reflected off a 

bright sunlit concrete or white-cardboard surface.

 NEVER LOOK DIRECTLY AT THE SUN, ONLY AT REFLECTED SUNLIGHT.

 Before you go outside to look at the Sun’s reflected light, take another look at the con-

tinuous spectrum produced by an incandescent filament, so you have a fresh mental image 
of a featureless spectrum, with which to compare during observations of the Sun’s light.

 In order to be able to see the spectra inside the spectrometer, you will have to find the 

right balance between shade for your eye, so you can see the pattern inside the spec-

trometer, while viewing a sunlit surface that is as brightly lit as possible.

 Sketch the pattern that you see, indicating the wavelengths of several absorption 
lines. Compare with the solar spectrum on the wall chart in the lab.

R E D O R A N G E Y E L L O W G R E E N B L U E V I O L E T

Sun

 Use the chart of the solar spectrum printed on the spectrometer to identify some 

elements in the Sun from your observations of absorption line wavelengths:

________________________________________________________________________

________________________________________________________________________
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Name___________________________________ Student #________________________

Lab Partners _____________________________________________________________

P H Y S I C S  1 9 0 :  P H Y S I C S  L A B  V I
P I N H O L E  I M A G I N G

(With thanks to Mehrdad Rastan)
Goals 

 In this lab you will analyze the world’s simplest imaging device, the pinhole “camera.” 
You will also compare images produced by a pinhole camera and a lens.

Equipment 

 1. Shoe-box pinhole “camera”; 2. Overhead projector and screen with cutout “L”;

3. Ring stand with ring, pointing rod, source, and screen; 

4. Optics bench with pinhole and crossed-arrow sources, lens, and viewing screen.

Background

 Consider an object which casts  light onto a screen, as 

illustrated to the right. We generally see only an indistinct 

“blob” of light on the screen, rather than a sharp image of 
the source. This  is because rays of light from many parts of 

the object can end up on any given part of the screen (two 

such rays are represented in the figure by the black lines with arrows). 

 A lens  works by redirecting light from each part of an object onto 

only one part of the screen. The same result however can be achieved using a pinhole 
“camera,” the world’s simplest imaging device. 

 The pinhole camera is nothing more than a box with 

a small hole to let light in, with a white sheet of paper as a 

viewing screen (instead of film) on the wall inside the box 

opposite the pinhole, and a tube through which the user 
can look to see the screen.

 [Sidebar: The pinhole camera will be ready to use 

when you come to the lab. If you want to make one at 

home, you will need a box about the size of a shoe box, a 

piece of cardboard tubing about 3 cm long (such as a toilet paper role), a sheet of white 
paper, a nail, a knife, and opaque tape. On one side of the box, cut a hole for the eyepiece. 

The hole should be about 4 cm off-center, as illustrated above. Make sure the tube fits 

snugly about half-way into the hole. Pierce the box in the center with a nail: the hole should 

be about 5 mm in diameter. Inside the box, cover the opposite wall with a white sheet of 

paper. The box should not have any other holes: be sure to seal any cracks with tape, and 
check that the inside of the box is completely dark when you look through the eyepiece with 

the nail hole covered.]
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Activity I: Pinhole on the world

 1. Go into the physics  lounge in the corridor outside the lab, 
and stand with your back to one of the windows. The TA will suggest 

a good location. 

 2. The pinhole camera has three holes. Start by covering the 

two smallest holes with tape. Look into the camera. You may need 

to shield your eye from stray light by blocking the side of your eye 
with your hands. You may also need a few minutes to let your eye 

adapt to the darkness in the box before you see anything. If you still 

do not see anything, move the box side-to-side or up-and-down. Ask the TA for help if nec-

essary. 

 3. Record what you see:

 4. Now repeat your observations using the two other holes, one at a time. How does 

the image compare with the different holes? For example, is the image larger or smaller, 

brighter or dimmer, sharper or fuzzier? Record your observations here:

 5. Using the “best” pinhole, observe how the image changes  as you move your body 

closer to and further away from the window. What do you find?

Activity II: Examination of the pinhole image

 1. Return to the physics lab. The overhead projector will be set 

up to project a cutout of the  letter “L” onto the projection screen. Use 

the pinhole camera to view the projected letter with your back to the 

screen. 
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 2. How does the image in the camera compare with what is on the screen? Is this 

consistent with your observations in Activity I? Record your observations here:

Activity III: Formation of the pinhole image

 1. To understand the formation of a pinhole 

image, use a small metal ring (supported by a ring 

stand) to represent the pinhole, as in the picture. 

 2. Use a rod to represent rays  of light that 
emanate from various parts of the object, repre-

sented by the letter “L” on a piece of cardboard 

(supported by a stand), through the pinhole, to the 

corresponding parts on the screen, represented by 

a white sheet of paper on another stand. 

 3. This  technique is  called ray tracing. Trace the image formed by the pinhole by 

having one end of the rod move over the outline of the “L”, while tracing the pencil on the 

other end of the rod over the sheet of paper.

 4. How does the orientation of the “image” traced out on the paper compare with the 

orientation of the “L” on the source? Draw your result here:

    Source   Image

    L
Activity IV: Experiments with the optics bench

 1. Place the lens on the optics bench, close to the light source. If the plastic viewing 

screen is on the bench, remove it.

 2. Project the image formed by the lens onto the blackboard past the end of the ta-

ble. Move the lens back and forth until you get a sharp image.
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 3. State what the image on the blackboard looks like and make a sketch:

 4. Remove the lens, and place the component holder with the piece of aluminum foil 

right up against the light source. 

 5. Place the small plastic viewing screen close to the aluminum foil. Move the view-

ing screen back and forth until you get a sharp image.

 6. State what you see on the viewing screen using the pinhole, and how it compares 

with the image you saw using the lens. Make a sketch:

 7. Remove the aluminum foil, and place the crossed arrow target in front of the light 

source.

 8. Put the lens back on the optics bench, this time near the center of the bench 

 9. Put the viewing screen near the far end of the optics bench, and then move the 

screen back and forth until you get a sharp image. Describe the image and how it is  similar 

to and different from the source (for example, is the image right-side up or upside down?):

 10. Compare your observations of the images formed by a pinhole and by lens. In 

what ways are they similar, and in what ways are they different? How does the ring stand 
experiment help you to understand the formation of these images?
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